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For todays’s session

Before the second session, please download the GGXLog program. The instructions are in the folder below
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Instruction how to download the program GenoGraphiX-LOG (GGXLog)

Instructions and user guide
DOWNLOADS
Carvemt Softwars retsane 219 fiwea 3|

Curvert Uner Gude resnase Version 10
e e 3 bty X133

- 2 oo 3 P =
Wl Windows ‘ Mac OS . Mac OS ’ Linux User Guide

1) Download the program on your computer {PC, Mac or Linus) (version 2.1.1 (Beta-3)
https: log.net/index.php#download

2) If you have preblems to download the program, see the Installation tutorials
https: log.net/usersupport.html
Make a File on your Desktop, for instance Name_GGXLOg
If your screen is small, change the Screen resolution to see all the command buttons.
* Forinstance, Windows: Settings = System -> Display > Resolution = Choose 1600 * 900
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Themes of today’s session

Writer awareness

Hands-on activities

Reflecting on the writer processes
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Real time studies in writing research

e Non-chronometric methods

e e.qg. think aloud
verbalisation, verbal
protocols

e Chronometric or measurable
methods

* e.g.real time studies
measuring cognitive
processes (log files)
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GenoGraphiX-Log
(GGXLog)

« Graph theory-based keystroke logging
software

» Data collection

» Analysis of writing processes and products
» Visualization of writing processes
(Caparossi & Leblay 2015)
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https://ggxlog.net/index.php
https://ggxlog.net/index.php
https://ggxlog.net/index.php

GenoGraphX-LOG

version 2.1.0 (Beta-3)

 Innovative method

- Examines the events in the writing process
 Looking for links between events

* Puts events in chronological order (Leblay
& Leblay 2019)

* The graph describes the relationships
between different points connected by lines
(cf. metro map)

« Good tool for visualizing the process;
colors play an important role (Leblay et al.
2022)

Loading 247

E U o
[item/ [GERAD

All the illustrations
are based on real
graphs from
GenoGraphiX-LOG
software.
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https://www.ggxlog.net/
https://www.ggxlog.net/
https://www.ggxlog.net/

GenoGraphiX-Log (GGXLog)

* Multi-method approaches are needed to describe complex

writing processes
* E.g. keystroke log files, background questionnaires, post-interviews

and/or eye-tracking techniques
 (Reveész et al. 2017; Galbraith & Baaijen 2019; Revesz et al. 2019;

Davoodifard 2022)
 In education, visualizations are often used to help learners to

understand complex themes or phenomenon (Vieira et al. 2018)
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Hands-on
activities
Instructions
(resolution,
collecting data
and analysing it)






Hands-on activities

a) Writing a text with the GGXLog program

b) Alternative: Writing a text on a computer & another task

Reflecting on the writer processes
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Hands-on activities: a) Writing a text with the
GGXLog program

Stay in the main room

a) Writing a text with the GGXLog program

Reflecting on the writer processes
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Hands-on activities: alternative b)

Go to the breakout room

b) Alternative: Writing a text on a computer & another task

Reflecting on the writer processes
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Main room exercise
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Changing the resolution (if needed)

« If your screen is small, change
the Screen resolution to see all
the command buttons.

e For instance, Windows: Settings
- System - Display 2
Resolution

- Choose 1600 * 900

All Apps  Documents Settings More ¥

Best match

:I Change the resolution

display
System settings

Settings
s Device Manager

:=+ Default apps

= Delete temporary files

Apps (3+)

Documents (5+)

of the

Change the resolution of the display

x 1080 (Recommen ded)

= 1050

= 900 I

1360 =

1280 =

1280 =

1280 =

1280 =

1280 =

1280 =

1152 =

1024 =

= 900

= 1050

x 768

768

1024

960

800

768

720

600

ged

763
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Breakout room exercise
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Breakout room
Alternative b) : Writing a text on a computer &
another task

- Write an argumentative text in English (max 15
minutes) on the following topic:

What is your opinion on student exchange?
What are the advantages? What are the disadvantages?

- Do not use any extra tools or dictionaries. Just your
mental lexicon.
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Main room exercise
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Create a folder on the desktop

Create a folder on

the desktop

* Click the right
mouse button

e Choose - New =
Folder

« Name the folder
e.g.
GGXLog Your Name

View
i Sort by
Refresh

Paste
Paste shortcut

Undo Copy

J Scan for malware

New >

1 Display settings
& Personalize

~

Folder

7 # Shortcut

B Microsoft Access Database
= Bitmap image
@ Microsoft Word Document

4| ) Microsoft PowerPoint Presentation

@ Rich Text Format

@ Microsoft Excel Worksheet
¢ Compressed (zipped) Folder

-~ . B
. L ’ : . "" Microsoft Publisher Document
‘4 & | (i‘.' = =| Text Document
“ 487 v >

GGXlog_Ma...

Mutta
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Open the program vou have downloaded

1. Search from the list

GGXLog
2. Open it

Project Help
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GGXLog

Project > New
GenoGraphX-LOG @

version 2.1.0 (Beta-3)
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Time Elapsed:  00:00:00 NoofChars 0 Nooffvents 0
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Start the program

e Choose Project > New
 Fill the formular

« Choose:
* Project type: Free writing
 Session Length: Long text
* File save > Browse

B | Participant Information and Consent Form %

__desktop

& The folder you created on the

e Fill Informant information

* First language: Your L1
 Tested language: Your L2

(English, French, Spanish etc.)

» Tick I grant consent

* Press the button Continue

Project Settings

Project type: @/ Free-writing Translating Editing Translation L7
Session Length: Short Text (Less than 10 mins) ®) Long Text (7]
File Save Location: C\Users\ankahin\Desktop\GGXLOG_Etunimi Sukunimi Browse...

Informant Information

First Name: Last Name:
Age

Gender: Male Female ®) Not Specified
First Languag

Tested Language: (7]

By ticking "I grant consent”, | herby authorise the researcher to use the information given above
and the data | generate in this programme for research purposes.

| grant consen t Cance Continue
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Write a short text in English (L.2)

* Write an argumentative text (max 15 minutes) on the following topic:

o D =

What is your opinion on student exchange?
What are the advantages? What are the disadvantages?

* NOTE! When typing, do not use shortcuts. Also, do not delete text by
painting with the mouse and pressing backspace. Do not delete whole

words with a shortcut.

Give a title
Start recording by clicking the button Record

When you have finished, click Stop and Save.

Verify in the desktop folder that you'll find a file with number indicating the
date and time "year:month:date:hour:minute:second” (yymmddhhmmss).
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Breakout room exercise
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Breakout room
Alternative b): Writing a text on a computer &
another task

« Use an Al tool (Chat GPT, Copilot etc.) and ask it to do the same
task:

What is your opinion on student exchange?
What are the advantages? What are the disadvantages?

« After the task, copy the Al text and make comparisons to your
own text.

« What was different? What was similar? Other comments?
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Making your own analyses

You have 20 minutes to examine your and the AI's writing
processes

Collect information and prepare yourself to present something
to the others in a small group or to the whole group
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Main room exercise
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How to analyze the collected data?

2

W/

4l UNIVERSITY
S OF TURKU

N



GGXLog

Project - Open
Desktop - Created folder
- File > Log file

GenoGraphX-LOG @ l
version 2.1.0 (Beta-3)
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GGXLog analysis: linear text

Project [RYMENE Help

Session R Session Replay

i 3
Graph Representation E g

Analysis » | 5-Notation Project  View Help

00:00:00/00:16:12

| Session Log | Session Replay | Linear Text X

Open the log file
Choose View
Notations = Linear
text

Save the linear text
setting with ticking
the box Show
pauses (2000
milliseconds)
Choose Format 2

1 Play E3 Close
w Settings Select: ® Format 1 Format 2
B ! Settings to Generate Linear Text X

Linear Text Settings
Pause Time (ms):
Pause Colour:
Text Colour:
Modifier Key Colour:
Navigation Key Colour:
Edit Colour:
Copy-Paste Colour:

Mouse Event Colour:

2000

W #0c4e00

W Black

W #3e8883

M #5c8100

W #bd2d28

W #e25a42

M #688bab

Show Pauses

- Default Colours:

Cancel Save Settings




Linear text
above, the
final text
below

GGXLog analysis: linear text

Help

Linear Text X

w Settings | ) Process | = [Export Select: Format 1 (®) Format 2

<MOUSE EVENT=>Toita opiskeluiden lomassa? Uksa<BACKSPACE3>hka vai mahdollisuus?<RETURN><RETURN>
<RETURN>Ty8k<BACKSPACE>skentely<BACKSPACEZ2=>ly opiskeluiden aikana on <3953>opiskelijamaailman kuuma peruna,
johon kantaa ottavat myd&s yhteiskunnalliset vaikuttajan Eduskunnassa asti. Téiden tekeminen nahdaan ahkeruutena ja riippuen
kysyttavan<BACKSPACE10>vastaajasta <4257>se nahdaan <3329>joko pakollisena pahana<5504> tai kannustettavana asiana..
<BACKSPACEZ2> Itse <3009>voin kokemuksen syvalla rintadganell <BACKSPACE>a todeta, ettei tydskentelyssé ole
<BACKSPACEO9>y opintojen aikana ole <3442>toivottavaa<2257>. <2352><BACKSPACEZ>, <BACKSPACEZ>
sd<BACKSPACEZ2>sen kuormittavuuden vupoksi<BACKSPACES>oksi. Tierty<BACKSPACEG6>Kuormittavuus tietysti riippuu tyon
laadusta ja maarasté, mutta itse opiskelleena ja t<BACKSPACE>samanaikaisesti tydskennelleena en voi
sus<BACKSPACE>ositella kyseistd' <BACKSPACEZ> komboa <2961>kuin vain niille, kskBACKSPACE=>joiden energiavarannot
ovat ehtymattomat. Kuinka mion<BACKSPACE3>oni <3072>meist' 0<BACKSPACE3>a opik<BACKSPACE>skelijoista oikeastaan
kuuluu tahan ehtymattdmien voimavarjo<BACKSPACEZ>o0jen <5584 >kastiin?<RETURN><RETURN><2738>0Opinnot ovat
kuormittavuusasteeltaan aloittain vaihtelevia, mutta yleisesti voisi sanoa kaikkien opintojen viev'<sBACKSPACE>&n aikaa ja
resursseja. <2290>Jos opiskelu olisi helppoa, tuskin siita tehtéisiin yhteiskunnassamme <4705>tdiden tekoon rinnastettava asia
<BACKSPACE>, josta saa tuloja valtion kassasta. <5345>Kuitenkin opintoja arvotetaan alemmasd <BACKSPACEZ2> kuin tydn
tekoa ja <BACKSPACE4>. ja usein kuuleekin ylistavaa puhetta niisté ihmisista, joille yksi nakki on liian véhan. Jaksavaiset ja
itselleen paljon tekemistd kahmivat inmiset ndhfdaan <BACKSPACEG>daéan nain ollen ylimaallisina ja <2993>parempina ihmisina,
iniden ansinids<BACKSPACFE?>sta vhteiskiunta nvirii<3169> eteenniin <MOLISE FVENT>

Toitd opiskeluiden lomassa? Uhka vai mahdollisuus?

Tybskentely opiskeluiden aikana on opiskelijamaailman kuuma peruna, johon kantaa ottavat my&s yhteiskunnalliset vaikuttajan Eduskunnassa asti.
Téiden tekeminen ndhdéaén ahkeruutena ja riippuen vastaajasta se ndhdadan joko pakollisena pahana tai kannustettavana asiana. Itse voin kokemuksen
syvalld rintaddnella todeta, ettei tydskentely opintojen aikana ole toivottavaa sen kuormittavuuden vuoksi. Kuormittavuus tietysti riippuu tydn laadusta
ja madrdstd, mutta itse opiskelleena ja samanaikaisesti tydskennelleend en voi suositella kyseista komboa kuin vain niille, joiden energiavarannot ovat
ehtymdttémat. Kuinka moni meistd opiskelijoista oikeastaan kuuluu tahdn ehtymattémien voimavarojen kastiin?

Opinnot ovat kuormittavuusasteeltaan aloittain vaihtelevia, mutta yleisesti voisi sanoa kaikkien opintojen vievdn aikaa ja resursseja. Jos opiskelu olisi
helppoa, tuskin siitd tehtdisiin yhteiskunnassamme téiden tekoon rinnastettava asia, josta saa tuloja valtion kassasta. Kuitenkin opintoja arvotetaan
alemmas kuin tyon tekoa. ja usein kuuleekin ylistavaa puhetta niista ihmisistd, joille yksi nakki on lilan vahan. Jaksavaiset ja itselleen paljon tekemista
kahmivat ihmiset ndhdaan nain ollen ylimaallisina ja parempina ihmising, joiden ansioista yhteiskunta kulkee eteenpain. Miksi opinnot ndhd&an
alisteisina téihin verrattaessa?



GGXLog analysis: statistics

Project RUEIE Help

Session R Session Replay

Graph Representation » L 4. 00:00:00/00:16:12

) Play

Notations 4
Satisics
| Session Log Burst and Fluency e
Statistics X

Text Length Analysis
Micro Analysis

Editing Distance

* Open View =
Analysis - Statistics

* Choose from the
Statistic settings what
items you would like
to examine

w Settings

kd Close

B | Settings to Generate Statistics

Statistics Settings

Pause Time (ms): 2000

v'| Show Event Analysis
V| Show Final Text Analysis
V| Show Time Analysis

V| Show Pause Analysis

Show Gene Analysis

Cancel

Save Settings




GGXLog analysis: statistics

Help

Statistics X

Event analysis =
Statistics
Events Analysis

above,
FI n a | teXt a n a IyS I S Total User Events 3715

Total Text Productions 3448
b e | OW Total Text Eliminations 196

Total Cut Events

Total Copy Events

Total Paste Events

Total Cursor Navigations

Total Mouse Events

w o o o o

Total Miscellaneous Events (e.g. Modifier Keys) 68

Final Text Analysis

Character Count (incl. Spaces) 3252
Character per minute (incl. Spaces) 200.67
Character Count (excl. Spaces) 2886
Character per minute (excl. Spaces) 178.08
Word Count 370
Words per minute 2283
Mean Word length 7.64
Std. Deviation in Word length 3.84
Sentence Count 26
Paragraph Count 6

Product to Process Ratio [Character Count (incl. Spaces):Total Text Productions] 0.94



GGXLog analysis: Graph Representation:
Progressive Graph (visualization )

B ' Settings to Generate Graph

Project BYUETM Help
Graph Settings

Session R Session Replay

Graph Representation » Session Graph 10:00:00/00:16:12 Pause Time (ms): 2000 Show Pauses 4 Close

T

Notations 4 Graph Statistics Show Text: v/| Show
Analysis g Graph Pauses Analysis Graph Mode: Manual ®) Automatic
I Session Log Node Scaling: Scaled Sphere @) Boxed Circles
Pause Node Colour: M #018c79 -
Append Node Colour: B #bd2d28 -

» Open Graph M,
Re p reS e ntati O n 9 Removed Node Colour: #ffff66 -

Deletion Colour: #8caech hd
L]
Progressive Graph o -
Copy Node Colour: #f6b656 - Default Colours

» Save settings

Graph Statistics

Node Subset Size (1-283): 10
Time Granularity (0.1-16.21 mins): 1.0

Pause Breakdown

v/| Paragraph Beginning |¥/| Sentence End v/| Within Words || Navigation
V| Paragraph End v/| Between Sentences  |V/| Edit v/| Unknown

WA/ TY
v/| Sentence Beginning  |v| Between Words V| Delete v/| Cursor Position §\ /é UNIVERSI

% S

S OF TURKU
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GGXLog analysis: Graph Representation:
Progressive Graph (visualization ) — Starting profile

ject  View Help

iion Replay | Progressive Graph X

)
5]
J

s

280 2

Al

W Settings ) Process = Export

Toita opiskeluiden lomassa? Uhka vai mahdollisuus?

Tydskentely opiskeluiden aikana on opiskelijamaailman kuuma peruna, johon kantaa ottavat my&s yhteiskunnalliset vaikuttajan Eduskunnassa asti. Téiden tekeminen nahddan ahkeruutena ja riippuen
kysyttavan



GGXLog analysis: bursts

Project BUETE Help

Session R Session Replay

g

Graph Representation » kad- 00:00:00/00:16:12

Notations »

Statistics

Session Log Burst and Fluency

Text Length Analysis
Micro Analysis

Editing Distance

« Analysis - Burst and

fluency
« Settings

Burst and Fluency X

(1 Play

‘ Ed Close

w Settings

B ! Settings to Generate Bursts and Fluency

Burst and Fluency Settings

Pause Time: 2000

Select Interruptions:
Pause
V| Edits with Backspace and Delete Keys
v/| Edits with Navigation Keys
/| Edits with Keyboard Cut-Copy-Paste
/| Edits with Mouse Clicks

V| Edits with Mouse Cut-Copy-Paste

Cancel Save Settings




Project View

Session Replay

Mo of Characters

GGXLog analysis: bursts

Help

Burst and Fluency X

LA L CANI TSRy

167

( X ®
____‘__. _____ f___90_ _ __i@_

@
. @

Iy s ’12
3250 .
22626 JI 23 27 1o
11 1 I
5
[} .|| I i

Total Burst Count

Total Characters in Bursts

Mean of Burst Fluency

10% Trimmed Mean of Burst Fluency
Mean Burst Length (Append)

Mean Burst Length (Insert)

Mean Burst Length (Overall)

W Settings ] | ) Process
159
® 131
[ ]
° - » 103
® o
L
.___ ____.!.. _____ e __4.___
.
a1
7 30 “ 38, 'm
'n” 3335
II r "i.l ”2 II" JII

Time (min)

-——0®. - -

™
L%
ﬂ

= Export
255
L
L
111
[ ]
® 08
% .
75 ?Tf' '.-’6
_&. >~ 86 o8 _ [ F——
- ,.. &. 51

‘ I j

Session Burst & Fluency Parameters

Parameter

101

3448

346.37 (Chars per min)
324 .26 (Chars per min)
34.75 Chars

4 Chars

34.14 Chars

Fluency in Burst (Chars per min)

Fluency
Insert

Append



Making your own analyses

* You have 20 minutes to examine your writing process
Collect information and prepare yourself to present something

to the others in a small group or to the whole group
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You can study - in pairs

Fluency, i.e. the amount of output, speed, length of pauses

|ﬁ Statistics

Linear text

~ Pausesin more detail
@ Uncorrected bursts or cognitive sequences more broadly

/ Correction and editing in more detail




Reflecting on the writer processes

* Main and breakout room groups

« Write your comments and
reflections in the group discussion

dred
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Feedback for the second session

m Feedback for the second session

Please write down your feedback concerning the second session.

The feedback is anonymous.
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Write your name on the Chat

 Attendance list
* Do not forget to write your name on the chat!
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Thank you for
your attention!

Get inspired g
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